
 

WEDDING PLANNER 
http://doc.freevision.me/wedding-planner 

 

  



Recommended Hosting Configuration 

For Wedding Planner Theme 
To run Wedding Planner Theme, you must be running WordPress 4.5 or higher, 

PHP5 or higher, and mysql 5 or higher. 

Recommended PHP Configuration Limits 

Many reported issues you may run into such as; white screen, demo content fails when importing and 

other similar issues are all related to low PHP configuration limits. The solution is to increase the PHP 

limits. You can do this on your own, or contact contact your web host and ask them to increase those 

limits to a minimum as follows: 

 max_execution_time 180 

 memory_limit 128M 

 post_max_size 32M 

 upload_max_filesize 32M 

Verify Your Current PHP Limits 

Check them by installing with this simple plugin. In addition, you can always contact your host and ask 

them your current settings and have them adjust, if needed. Many hosts will try to keep the PHP limits 

low without reason. However you are paying for it, and therefor should be getting your moneys worth. 

 

  

http://wordpress.org/extend/plugins/wordpress-php-info/


Install a WordPress Theme 

There are two ways going forward to install your newly purchase WordPress theme: 

1. Using the WordPress upload 

2. Using FTP 

Using the WordPress upload 

1. Download and unzip the theme archive from your ThemeForest account 

2. Log in to your WordPress Dashboard (Ex: http://yourwebsite.com/wp-admin) 

3. Go to Appearance > Themes 

4. On the next page, click the Add New button 

5. In the displayed screen click the Upload Theme button 

6. Choose the file [themename].zip, downloaded from your ThemeForest account. Select it and 

press the Install Now button 

7. In the next screen, click on the Activate link 

8. With the theme’s name selected in the sidebar follow the theme and demo content install 

instructions in order to make your website look exactly like in our demo preview 

9. Reminder 

Don’t forget to unzip the archive downloaded from your ThemeForest account in order locate the 

[themename].zip file needed for the WordPress upload. 

Installing the Theme using FTP 

1. Download and unzip the theme archive from your ThemeForest account 

2. Locate the [themename]-child and [themename]-parent folders inside 

the Licensing & Plugins / full wp theme for manual install folder 

3. Connect to your server using a FTP client and locate the wp-content/themes folder 

4. Upload the [themename]-child and [themename]-parent folders inside the wp-

content/themes folder on your server 

5. Log in to your WordPress admin and go to Appearance > Themes 

6. Activate the Child theme 

7. Attention 

It’s mandatory to activate the Child theme and not the Parent one. Find out why in this article . 

8. With the theme’s name selected in the sidebar follow the theme and demo content install 

instructions in order to make your website look exactly like in our demo preview 

 

http://doc.freevision.me/xside/knowledge-base/theme-customization/


Installation & Dummy Data& 

Configuration Video Tutorial 
https://youtu.be/M6wiGjarWKY  

 

Please also check: Mega Menu Doesn't Look Same 

 
 

  

https://youtu.be/M6wiGjarWKY
http://doc.freevision.me/wedding-planner/knowledge-base/mega-menu-doesnt-look-same/


Mega Menu Doesn’t Look Same 
Appearance > Menus  

  

select Primary Menu then expand HOME menu, and check "Mega Menu?" option if unchecked.

 

then expand ABOUT menu, and check "Mega Menu?" option if unchecked.



 Then follow the instructions on the following image



 once you done SAVE your menu. 

  



Why imported dummy data doesn’t 

look identical on Wedding Planner 

Theme Demo? 
The dummy data import option from the Import/Export tab of the theme options is not an exact copy 

of the theme demo but one that is very close. Some of the images and video are not allowed to be 

redistributed and so it isn’t included. In case you'd like to buy used stock materials separately we do 

provide a full ID list for images. Feel free to ask for it. With each feature update the dummy data is 

updated to include an example of the new feature(s) and we will continue to update the online 

documentation with examples and how-tos. 

 

  



Menu Not Appearing 
Please make sure you have generated and set menus on "Appearance > Menus". "Header Menu" and 

"Logged In Header Menu" menu locations have to be filled to make primary menu work as expected. 
"Logged In Header Menu" could be usable to use different menu layout than 

standard, if you are planing to some more with registered and logged in 

users. 

 

  



Updating Your Theme 
We are strongly recommended to install "Envato Toolkit" plugin for ease of use. Once necessary plugin 

installed and activated "Envato Toolkit" menu will be available at your admin side. Important : If you 

have missing plugins or having issues to install any of them, all the related could be found under 

"recommended-plugins" folder within the downloaded package. 

User Account Information 

To obtain your API Key, visit your "My Settings" page on any of the Envato Marketplaces. Once a valid 

connection has been made any changes to the API key below for this username will not effect the 

results for 5 minutes because they're cached in the database. If you have already made an API 

connection and just purchase a theme and it's not showing up, wait five minutes and refresh the page. 

If the theme is still not showing up, it's possible the author has not made it available for auto install 

yet. Marketplace Username: Enter your Envato marketplace username. Secret API Key: Enter 

your Envato marketplace Secret API Key (http://themeforest.net/user/[your-username]/api_keys/edit, 

Login to your Themeforest account, Settings > API Key) 

Backup Information 

This plugin will automatically save your theme as a ZIP archive before it does an upgrade. The 

directory those backups get saved to is wp-content/envato-backups. However, if you're experiencing 

problems while attempting to upgrade, it's likely to be a permissions issue and you may want to 

manually backup your theme before upgrading. Alternatively, if you don't want to backup your theme 

you can check the box below. Skip Theme Backup: Strongly recommended keep unchecked. 

 

  



 
In basic, featured image / heading component with icon support.  

Icon : Search and choose on of available icon for your list from more than one thousand hand crafted 

& picked type icons. 

http://doc.freevision.me/buildme/wp-content/uploads/sites/8/2015/04/title_with_icon_settings.png


 Icon Size : regular (16px), large (32px), xlarge (48px), xxlarge (64px) and xxxlarge (128px) options 

are available.  

Icon Alternative Color : If you like to use another color for your icon but not from content, use 

it.  

Icon Background Type : 4 different option available for it. 

Clear : Only icon, no background. 

Rectangle : Square background for your icon. 

Rounded : Circle background for your icon. 

Circle : No background, only circle line around your icon. 

Icon Background Color : Background color for your icon. 

Icon Shadow Color : Use this option to add realistic shadow to icon.  

Heading Style : Select size of title. H1,H2,H3,H4,H5 and H6 options are available.  

Link  (on icon) : URL to go on click event.  

Link target : Target window to use on click event. 

Title : Title of the box.  

Font Color : Will affect only text color, not icon.  

Connected : When you select "yes" your Title With Icon components will be tied with a dashed 

border to next one.  

Content : Summary / Short Details of the box. 

  



First Steps With WordPress 

Now What? 

You've just completed the 5 Minute Installation of WordPress or one-click install from your web host. 

Now what? Please see following link   

 

  

http://codex.wordpress.org/Installing_WordPress
http://codex.wordpress.org/First_Steps_With_WordPress


How to create a child theme? 
We strongly recommend to use child theme when you want to customize our theme. You can preserve 

your parent theme if you update the theme. Here is the detailed instruction –

http://codex.wordpress.org/Child_Themes#How_to_Create_a_Child_Theme. 

 

  

http://codex.wordpress.org/Child_Themes#How_to_Create_a_Child_Theme


“Style.css” is missing error, while 

installing theme 
You will get this error if you are not installing a theme correctly. To install a theme properly please 

follow these steps: 

1. Unzip the downloaded archive 

2. Find the “wedding-planner.zip” file 

3. Install the file 

Enjoy. 

 

  



Single Post / Project 404 Error 
To fix this follow the steps below: 

1. Go to Dashboard > Settings > Permalinks and change the permalink structure to something else 

and save the changes. 

2. Set the permalink structure back to the desired format and save again. 

Now all the post types should be displayed correctly. 

 

  



How to use the Revolution Slider WP 

Plugin ? 
Please see ThemePunch's documentation about their plugin here . 

 

  

http://revolution.themepunch.com/documentation/


How to translate a theme 
Our Themes are translation-ready. Every theme contains a language file with the file ending .pot ( 

located in `wp-content/themes/themename/lang/` ) which you can use to translate the theme. The .pot 

file is basically a list of all the text lines used in the theme files in English language. Moreover a theme 

includes .po and .mo files. First are created from the .pot file and contain both the original language 

(English) and all translated text strings from the translated language. Therefore these files are named 

according to their language codes. (de_De.po, nl_NL.po or es_ES.po for example). The .mo files are just 

compiled exports from the .po files and used by WordPress to translate the theme. The easiest way to 

translate your theme locally is by using the PoEdit program. Download the files ( located in `wp-

content/themes/themename/lang/` )  to your local computer, and edit via PoEdit program. 

 

  

http://poedit.net/


Overriding a script from the parent 

theme 
Sometimes customization of a theme can’t be achieved only by editing the php files. In few cases you 

will need to make changes to the scripts too. In order achieve this you will need to deregister a script 

from the parent theme and use another in your child theme. Here is the example code that you need 

to paste in function.php from child theme: 
<?php  

function register_custom_child_script(){ 

 wp_deregister_script( 'wedding-planner.js' );  

 wp_enqueue_script( 'wedding-planner', get_stylesheet_directory_uri() . 

'/scripts/wedding-planner.js', false,true ); 

} 

add_action('wp_enqueue_scripts', 'register_custom_child_script'); 

?> 

After this you will be able to use wedding-planner.js script from your child theme folder. 

 

  



How to add own favico? 

Add your own Favicon 

If you aren’t familiar with Favicons, they are the little images that show in the browser tabs or 

bookmarks for a site. They take a bit more care when creating the image file since they are so small 

but there are some great resources on the web to make that easier. 

Setting up Your File 

A quick Google for “Creating your own Favicon” should help you find one of the many sites available 

these days which will help you in creating your file. 

Upload the Favicon file 

Once you have your new favicon created and read you can upload it to the Theme Options > General 

Options tab and the theme will then add it to the site code so that browsers can recognize it. (see 

attached screenshot) 

 

  

http://en.wikipedia.org/wiki/Favicon


Full Page Revolution Slider 
If you like to build a full page revolution slider, please follow the steps 

below. 

 First of all, you have to use "Revo Full" page template. 

1. Select your slider type. 

2. Select your Slider Layout as Full Screen. 

3. Offset containers, this is important. You have to use "#revo-offset-container" in order to make it 

work as expected. NOT NECESSARY 

4. Grid Settings, Grid Width we have used 1920 

5. Grid Settings, Grid Height we have used 890 

 

  

http://doc.freevision.me/coiffeur/2014/10/25/page-templates/
http://contrast.freevision.me/help/wp-content/uploads/sites/2/2014/01/revo-full.png


How to set home and blog pages 

Make your homepage the blog 

If you want to have the home page default to your blog then you don’t need to select anything from 

the Frontpage Settings dropdown. All of your posts will automatically show on your home page. You 

can set the number of posts to show from your WordPress Settings>Reading page. 

Set a Page as your Homepage 

Use the dropdown to select any previously created page as your homepage instead of showing blog 

posts. Once you’ve saved these settings you can visit your site and you will see a static page instead of 

blog posts. You then have the choice of choosing a specific page to automatically output your blog 

posts just like the front page would be default. 

Choose the layout of your Blog Page 

XSide lets you choose a number of options for how your Blog and posts will look throughout your site. 

All options are in the theme options “Appearance > Teheme Options > Layout > Content/Page/Post” 

tab. Also you can choose a blog listing templage via "page templates" (see attached screenshot)



   

How to choose a Blog Template 

Please see attached screenshot. 



    

 

  



Set up Navigation Menus 
BuildMe Theme support for Custom Navigation Menu, and here are quick instructions on how you can 

create a custom menu for your theme. 

1. Navigate to Appearance → Menus section 

2. If you don’t have any menus, create one and click on the Create Menu button. 

3. From the boxes on the left select pages or categories that you want to include in your menu. 

4. A Home menu can be found in View All tab in Pages. 

5. Drag and drop item from your menu to put them in the order you want or to create sub-menus. 

Don’t forget to save your modifications. 

6. Assign your menu to a theme location, or create a new custom menu if your theme has more 

than one navigation. (see attached screenshot) 

 

 

  

http://doc.freevision.me/buildme/wp-content/uploads/sites/8/2015/04/creating_main_menu.png


Where Do I Find Used Stock Images? 
IMPORTANT NOTE: All presented, demonstrated layouts has been prepared for only show you 

visually how capable of and what can you do with it in different industries. Used images in previews 

such as slider images, thumbnail, all conceptual images NOT INCLUDED in the package due to 

copyright issues. We carefully  hand-picked stock materials to create a realistic business website. Most 

clients/individuals want to keep used stock images. So we provide a full list of used stock materials on 

demo site. Please download list file. 

 

  

https://dl.dropboxusercontent.com/u/2478367/stock_id_list_wedding_planner.txt


How do I translate the theme into 

different language? 
Translating a theme is very simple to do. This requires you to download either WPML and 

or qTranslate. If you want something more automatic, I recommend using bing translator which is free 

up to 1,000,000 characters translated monthly. 

 

  

http://wpml.org/
http://www.qianqin.de/qtranslate/
http://www.microsofttranslator.com/widget/


How To Change Background 
Our themes allow you to customize the background of your theme by either uploading an image or 

selecting a color. Go to Appearance → Theme Options → Color Options  →  Background Styling in your 

WordPress dashboard.  

– Background Color : This option will affect only page background. 

– Custom Background Image : Upload or choose custom page background image. (see 

attached screenshot)  

– Background Image Size : Only available on browsers which supports CSS3.  

– Background Image Repeat : Adjusting image position due to different requirements.  

– Background Image Attachment : Adjusting image position due to different 

requirements. 

 

 

Post Formats 

http://doc.freevision.me/buildme/wp-content/uploads/sites/8/2015/04/bg_styling_options.png


All available Post Formats usable on your theme. See; 

 Standard 

 Aside 

 Gallery 

 Link 

 Image 

 Quote 

 Status 

 Video 

 Audio 

 Chat 

Standard 

Classic post, a featured image could be set and anything could be placed inside of it. 

Gallery 

Any gallery inserted into post will be converted into Royal Slider based touch slider. 

Link 

Simply type an URL into your post. 

Video, Audio 

Paste path of your YouTube, Vimeo or SoundCloud path to use this format. 

Chat 

Must be in following format in order to work as expected. 
Abbott: Strange as it may seem, they give ball players nowadays very 

peculiar names. 

 

Costello: Funny names? 

 

Abbott: Nicknames, nicknames. Now, on the St. Louis team we have Who's on 

first, What's on second, I Don't Know is on third-- 

 

Costello: That's what I want to find out. I want you to tell me the names 

of the fellows on the St. Louis team. 

 

Abbott: I'm telling you. Who's on first, What's on second, I Don't Know is 

on third-- 

 

Costello: You know the fellows' names? 

 

http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#standard
http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#gallery
http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#link
http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#videoaudio
http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#videoaudio
http://doc.freevision.me/wedding-planner/wp-admin/admin.php?page=shaver-ozy-shaver-help-gen-output#chat


  



Custom Google Map 
Standard Google Map with custom coloring options to create endless possibility for your map. Also 

supports custom pin icon. 

 

Google Map 

Google Maps API Key : Please supply an API key in order to run map on your page. Follow 

"Learn how to get an API Key" link to learn how to get a key. Height : Set a height for your map in 

pixels. Address : Enter an absolute address to point on Google Map. Please confirm your address 

before publish on Google maps. Zoom Level : Select initial zoom level for your map. Custom 

Icon : Upload/Select custom image to use as pin on your map. Hue Color : Select a custom color 

to hue your map. Saturation: Enter a value to set saturation of your map. Lightness : Enter a 

value to set lightness of your map. See: http://wedding-planner.freevision.me/contact/  

http://freevision.me/google-maps-key/
http://wedding-planner.freevision.me/contact


 

 

  



Count To 
Sub Title : Counter title From : Where counter will start to count from To : Where counter has to 

stop counting at Sign : A sign like % or whatever you like to show before or after the number. Sign 

Position: Where sign will be placed. Left or Right options are available. Fore Color : Font color of 

the component. CSS Animation: Select type of animation if you want this element to be animated 

when it enters into the browsers viewport. Note: Works only in modern browsers. 

 

  



Separator (Divider) With Caption 

 Generates a styled Divider With Caption where it’s placed.  

http://doc.freevision.me/buildme/wp-content/uploads/sites/8/2015/04/separator_with_caption.png


Caption: Divider caption.  

Border Style: Solid, Dotted, Dashed and Double options are available.  

Border Size: Size of divider border. 

Border Color: Color of your divider.  

Caption Align: Where your caption will be aligned.  

Caption Position: Where your caption will be placed.  

More Customization : Set it on to enable Width and Align options.  

Width: Width of your divider component.  

Align: Since you can set a short component via Width option, you can align it to available positions.  

Css Animation : Select type of animation if you want this element to be animated when it enters 

into the browsers viewport. Note: Works only in modern browsers. 

 

  



Title With Icon 



Custom Widgets 



 



Included 5 custom widgets for Wedding Planner theme, as listed below; 

- Custom Menu : Create a custom collapsible ( accordion ) menu from any available menu.  

- Flckr Widget : Gets images from desired Flickr source.  

- Latest Posts : Will list posts in 3 different type. Very handy widget in case.  

- Twitter :Display your latest twitter feed on footer bar.  

- Social Bar : This widget will put social network icons which previously set on Theme Options > 

Social panel.   

 

  



Site Optimization Tips 
If your site is not running as fast as you’d like, there could be a few different issues. Please check out 

official wordpress tips & rules: WordPress Optimization 

 

  

https://codex.wordpress.org/WordPress_Optimization


Price Table Component 
Pricing Table component will help you to publish pricing table on WordPress page. It's easy to manage 

tool. Here’s a preview of the pricing table back-end and front-end.

 

 

  

http://doc.freevision.me/xside/wp-content/uploads/sites/9/2016/03/pricetable.png


 

Social Icons 
Wedding Planner includes a large set of social icons that can be used all throughout the theme. These 

social icons are a custom font icon so will always be super crisp and not require any images. Using a 

font icon also allows us to have advanced color options. Social Icons can be used in several different 

areas.  

 

Accounts – Accounts tab in Theme Options is where you will insert your custom social media links 

for each network you want to display. The URL’s you enter on this tab will apply to the social icons in 

the header and footer. For example, if you want to display the Facebook icon in the header or footer, 

you need to insert the URL of your Facebook page in the corresponding field. (see attached 

screenshot) 

Icon Sorting – The Social tab in Theme Options also allows you to manually sort the social icons in 

the order you wish them to appear. Beside each social network field can be sort drag&drop. Use your 

mouse to drag and drop the field into place. Set the order of icons you desire then click save. The 

order you set on this tab will apply to all social icons throughout the site: header and footer. (see 

attached screenshot)  



 

 

  



Configure Widgets 
To add a widget in your theme’s widgetized zones, navigate to wp-admin → Appearance → Widgets. 

The big panel on the left side shows all available widgets. The small panels on the right are the 

widgetized areas. To add a widget: drag and drop the widget from the left panel to the right 

panel. To remove the widget: drag the widget back to the left panel (Available Widgets panel). If 

you want to keep the widget setting for future use, drag it to the Inactive Widgets instead of the 

Available Widgets panel. It will save your widget settings. To retrieve the widget, drag the widget from 

Inactive Widgets panel instead of the Available Widgets panel. 

 

How to protect my WordPress site? 
I personally recommend a few options. First you need to make a stronger password for your 

login minimum 12 characters and avoid using admin as your username. Next is to protect your ht-

access file. This is where your WordPress theme and other plugins write on and can cause 

vulnerabilities, I recommend BPS Security Plugin. 

 

  

http://strongpasswordgenerator.com/
http://strongpasswordgenerator.com/
http://wordpress.org/plugins/bulletproof-security/


How can I make my WordPress site 

faster? 
And next to make your website faster gets a little complicated, so please download W3 Total 

Cache after you do that please take a look at some articles to help you further. 

 

  

http://wordpress.org/plugins/w3-total-cache/
http://wordpress.org/plugins/w3-total-cache/


How can I perform better Search Engine 

Optimization practices? 
To perform better SEO practices takes a lot more, but this is a great start. This plugin will help you with 

titles and other seo properties. I recommend Yoast SEO, which is the most popular plugin for SEO. 

 

  

http://wordpress.org/plugins/wordpress-seo/


How many websites can I install a 

theme on? 
Every theme purchase is activated per license, the more licenses you purchase, the more websites you 

can use your theme on. 

 

  



How do I receive a refund for a 

purchase I made? 
I believe you will be satisfied with your purchase with our theme. However in case of refund request 

must contacted with Envato. For more info please check out Envato Refund Policy 

 

  

https://help.market.envato.com/hc/en-us/articles/202821460-Can-I-Get-A-Refund-


How To Create A New Revolution Slider 
Wedding Planner includes the popular Revolution Slider Created By ThemePunch. This slider is a 

beautifully animated slider that is 100% responsive and has some amazing options. We cannot cover 

everything here but we outline how to setup a slider and how to add slides to it. * Your purchase of 

Wedding Planner includes a copy of the Revolution Slider. If you wish to receive auto updates and plugin 

support from ThemePunch, it requires a separate purchase of the plugin. 

How To Create A New Revolution Slider 

Step 1 – Click on the Revolution Slider sidebar item in your admin section, then click the New Slider 

button.  

 

Step 2 – Select the Content Source type. If you choose Post-Based Slider or Specific Posts, please 

refer to the Revolution Slider Docs for information on how to set those Content Source types up.  

 

Step 3 – Insert a slider name and alias. The alias text will generate a shortcode that can be used in 

the editing field of pages or posts.  

 

Step 4 – Then select a layout in the Select a Slider Type box, each type will have its own settings. 

Once you’ve selected a Slider Type, you can also choose to load a preset from that Slider Type.  

 

Step 5 – Set the layout and resolution settings under the Slide Layout box. Here, you can set different 

heights and widths for your slider when viewed on different mobile screens or viewports.  

 

Step 6 – On the right hand side, you’ll find many more options you can set for you slider, such as 

Layout & Visual settings, Navigation, etc. Each option will have a self-explanatory description, so feel 

free to explore each tab and test the options out.  

 

Step 7 – Once you are done, click the Save Settings button at the very bottom of the page, or the 

green save icon on the righthand side of the screen. 

http://codecanyon.net/item/slider-revolution-responsive-wordpress-plugin/2751380?ref=ThemeFusion


  

 

  

   

How To Add Slides To Your Slider 

Step 1 – Select the Slider you’d like to add slides to from the Revolution Slider list.  

 

Step 2 – Hover over the Add Slide button and select the type of slide you’d like to add. Once 

selected, it will create a new blank slide. 

 

 Step 3 – You can change the title of your new slide by hovering on it, and clicking the name field. 

Enter your new name, then click the pencil icon right beside it to save your new slider name.  

 



Step 4 – Before you reach the Slide Editor, you’ll find additional tabs that allows you to set the slide’s 

Main Background, General Settings, Slide Animation, Link & SEO, etc. We won’t go into detail on what 

each option in these tabs do, but please feel free to check out each option.  

 

Step 5 – Below the page is the Slide Editor. To add a new layer, hover over the blue Layer icon on the 

top left corner of the canvas and select which type of layer you’d like to add. You can add a Text/HTML 

layer, an Image layer, a Video layer, a Button layer, or a Shape layer.  

 

Step 6 – Once you add a layer, You can customize it further by using the tabs on top of the canvas. 

These tabs are the Style tab, Animation tab, Loop Animation tab, Visibility tab, Behaviour tab, etc. We 

won’t go into detail on what each option in these tabs do, but feel free to check out each option.  

 

Step 7 – You can manipulate each layer on the canvas using the transformation points and the 

various icons above it, such as the text icon, resize icon, delete icon and duplicate icon.  

 

Step 8 – To view your slider in different viewports, hover over the blue desktop icon on the top right 

corner of the canvas. Select which viewport you’d like to view, and the canvas will adjust the resolution 

accordingly. You can then adjust your slider to fit the current viewport.  

 

Step 9 – Below the canvas is the Animation Timeline. Here, you can see all the layers you currently 

have. You can rearrange layers here, and you can also click the Play button to Preview the slide’s 

animations.  

 

Step 10 – Once finished, click the green save icon on the right hand side of the screen. Keep 

repeating this process for any new slides you’d like to create. 

 



 
 

 
    

Revolution Slider Mobile Padding Class 

When using a 100% width slider, content may need to sit directly on the edge of the site width so it 

aligns with the logo and other page content. However on mobile devices, the logo and other page 

content has padding applied so it is not right on the screen edge. If you want your slider content to 

also have the same padding on mobile so it aligns with other content, you can use a custom class on 

each layer in your slider. Insert fusion-revslider-mobile-padding in the “classes” field located 

in the “Layer Links & Advanced Params” section of the slider creation page. 

Here Is A Screenshot That Shows You The Various Areas Of 

The Slider Creation Page Described Above. 



 

 



How To Export/Import Your Revolution 

Sliders 
The Revolution Slider allows you to easily export/import your slides. It’s always a good idea to backup 

your slides so you can easily import them again if you ever need to. Making animated slides takes a lot 

of time, make sure you export the data so you don’t ever lose the time you’ve spent on them. The 

Revolution Slider requires you to export each slider individually. Export each slide you have made and 

it will give you an individual zip file that contains all the necessary files. 

How To Export Revolution Sliders 

Step 1 – Go the the Revolution Slider tab in your WP Admin, and open the slider you’d like to 

export. Step 2 – Switch to the Slider Settings tab on the top of the page. Step 3 – On the right, you 

will find the ‘Import / Export / Replace’ dropdown. Click it to expand the tab and view the 

options. Step 4 – Switch to the Export tab, and click the Export Slider button. Step 5 – Once it’s 

finished downloading, you will receive a .ZIP file of your 

slider. 

   

How To Import Revolution Sliders 

Step 1 – Go the the Revolution Slider tab in your WP Admin, and click the Import Slider button.  

 

Step 2 – Choose the .ZIP file of the slider you’d like to import.  

 

Step 3 – Once you’ve chosen the .ZIP file, an Import Slider button will appear.  

 

Step 4 – Click the Import Slider button, and wait for it to finish uploading.  

 



Step 5 – Once it’s finished uploading, you will now see your imported slider in the list of Revolution 

Sliders available.  

 

   

How To Import Revolution Slider v5 Demo Sliders 

In the new Revolution Slider version 5.0 by ThemePunch, They’ve introduced the Free Slider Exchange. 

The Free Slider Exchange is a database of both official and user submitted slider templates that you 

can download for free and use on your own website. To learn more about this new feature, please 

keep reading below. 

 

IMPORTANT NOTE – Using the new ‘Add Slider Template’ option will not 

work unless you have a separate, registered license for this slider plugin. If you 

only have the Revolution Slider through the Wedding Planner theme, then you 

will need to use an alternative method, explained below. 

Alternative RevSlider Demo Slider Import Method 

Step 1 – To start downloading the slider templates, go to this link here.  

 

Step 2 – Hover over the slider of your choice then click the Download link. A .zip file containing the 

demo slider will be downloaded to your computer. 

 

Step 3 – Once you’ve downloaded the slider of your choice, you can now import it. To import the 

slider, go to your WP Dashboard then to the Revolution Slider tab. Click Import Slider and follow the 

on screen prompts. 

 

IMPORTANT NOTE – These sliders include all of the media required and as a 

result some of the .ZIP files are fairly large (Almost 10MB+). 

http://revolution.themepunch.com/free-slider-exchange/
http://revolution.themepunch.com/free-slider-exchange/


 
 

 

Failed Demo Slider Import 

If the Demo Slider Template fails to import and you see the following error: 

Warning: POST Content-Length of 15343652 bytes exceeds the limit of 8388608 

This error shows us that the server’s default max_post_size for PHP is less than the imported file size. To 

resolve this, please contact your hosting provider and request that they change PHP Post Max Size to 

at least 32M. Adjusting this is done by increasing the PHP configuration limit in the servers php.ini file: 

post_max_size=32M 

 

  



Before You Submit A Ticket 
To help speed along your request, we require that you follow the steps below before submitting a new 

support ticket. This is for the benefit of everyone and will help make the entire process more efficient. 

It’s very important and we ask that everyone who posts follow these steps. 

Please Check The Following Before You Create A Ticket 

 Make sure you are running the latest version of Wedding Planner and the latest version of 

WordPress. 

 Always check the Important Update Information first. 

 Check our Documentation and Knowledgebase for the answer to your question. 

 Disable any additional 3rd party plugins you may be using to see if it fixes the issue. 

 If you cannot find the answer to your question, fill out this form and our support team will 

help. 

Click Here To Submit A Ticket 

 

  

http://doc.freevision.me/wedding-planner/knowledge-base/updating-your-theme/
http://doc.freevision.me/wedding-planner
http://doc.freevision.me/wedding-planner
http://doc.freevision.me/wedding-planner
http://freevision.ticksy.com/
http://freevision.ticksy.com/


Google Maps Not Working? 
There are a few reasons why your google maps may not be working. Please see below for 

common issues.Issue 1 – Use a correct address and not google map embed code, or 

longitude/latitude. It has to be a written address, Ex: 775 New York Ave, Brooklyn, Kings, 

New York 11203Issue 2 – Third party plugins may be conflicting with the map feature. 

Please disable any plugins that were not included with Wedding Planner to see it if fixes the 

issue. If it does, enable the plugins one by one to find the culprit. 

 

  



Customizing 404 Page 
Theme Options > Appearance > Layout > Content / Page / Post : Custom 404 

Page option will be useful in this case. But, first create a 404 page as you desired to simply select it 

from this option. 

 

  



TypeWriter Component 

 
Do you want to display flash news / post titles in your webpage? This component help to display 

posttitles in your page  as a loop with typewriter effect. Here is how to manage component step by 

step. 

  

  

http://doc.freevision.me/xside/wp-content/uploads/sites/9/2016/03/typewriter.png


Individual Page Options and Editor 

 

 

  



Settings : Wedding Planner Essentials 

 

 

  



Plugin Recommendations 

If you already have a theme installed, you might want to run a security scan, or have a security-minded 

developer look through the theme code. Ditto for any plugins you might have. 

After you’ve selected your theme, the next step is to start picking plugins. When it comes to plugins, 

you need to be just as careful as you were with picking a theme. Even popular plugins can contain 

vulnerabilities, and developers can sometimes be slow to fix them (or perhaps put them there 

themselves). For that reason, I recommend using as few plugins as possible to get the job done. That 

said, from a security perspective, here are the plugins I highly recommend: 

 Better WP Security – This is sort of an all-in-one security option. It handles a variety of tactics 

covered in this post. Can overlap with other plugins, so be careful. Free. 

 Limit Login Attempts – Exactly what it says, and a phenomenal way to deter brute-force 

hacking attempts on a site. Free. 

 Akismet – Great way to filter out a lot of crap before it ever touches your site. If your site is 

easy to spam, it might also be easy to hack, so make it a hardened target on all fronts. Paid. 

 Sucuri Security – When you pay for this service, you get a plugin to install on your site that 

helps with the monitoring and hardening process. It has overlap with other plugins though, 

such as Limit Login Attempts and Better WP Security, so you don’t want to use all of them at 

once. Paid. 

 CodeGuard – Great backup service that lets you easily roll back if you ever do get hacked. 

Also, people don’t back things up nearly as often as they should, so doing it automatically is 

handy. Paid. 

 CloudFlare – CloudFlare is a CDN, but also so much more. It has some great security features 

built in, and comes in both free and paid versions. 

 Google Authenticator – Enables two-factor authentication on WordPress, which is awesome. I 

use two-factor wherever it’s offered, because it rocks. Free. 

 Stealth Login Page – You can’t crack what you can’t find. This plugin hides your login page 

without needing to edit .htaccess files. Free. 

 WordPress SEO by Yoast – Not only does this have great SEO benefits, but it allows you to 

easily edit your .htaccess file from within the WordPress admin, which is very handy. Free. 

If you opt to use WP-Engine for your hosting, be aware that they are very strict on what plugins they 

do and don’t permit. I find this pretty annoying, and while I understand their reasons, I really like some 

of the plugins they don’t permit. 

 

  

http://wordpress.org/extend/plugins/better-wp-security/
http://wordpress.org/extend/plugins/limit-login-attempts/
http://akismet.com/
http://sucuri.net/services/preventive
https://www.codeguard.com/
https://www.cloudflare.com/
http://wordpress.org/plugins/google-authenticator/
http://wordpress.org/extend/plugins/stealth-login-page/
http://yoast.com/wordpress/seo/


Installation Instructions 

Installing your theme is just as easy and installing WordPress. You are going to have to download 

WordPress first and upload it to your server. The following will show you how to install and get you 

setup and ready to go 

Installation 

First you are going to have to download WordPress and install the files on your server, there are many 

ways to accomplish this. Please click the following links below to help you further. 

 Download the latest version of WordPress 

 Learn how to install WordPress on your hosting provider. Installation Instructions 

Demo Content Saving time on making pages and getting the hang of WordPress and our themes 

will make your life simpler by uploading the xml file provided within "dummy-data" folder, once 

you have the file follow the following instructions for upload: 

1. Log into your site as an administrator. 

2. Make sure you activated your new theme before proceeding. 

3. Go to Tools → Import 

4. Choose “WordPress” from the list. 

5. Upload the demo content .xml using the form provided on that page. 

6. You will be asked to map the authors in this export file to users on the blog. For each author, you 

may choose to map to an existing user on the blog or to create a new user. 

7. You will then have the choice to import attachments, so click on the “Download and import file 

attachments” box. 

8. Please be patient while WordPress imports all the content. Posts, Pages, Projects, and Menus are 

imported. You will need assign the menu a theme location & you’ll need to configure widgets 

Upgrading 

Upgrading your theme is a simple click process that you will not need to worry. Please make sure to 

use our theme-child.zip and install it and make changes and add files as you please. All upgrades will 

of course overwrite any existing changes you made on parent theme, so make sure to install child 

theme and make changes. 

Important FAQ 

 How to optimize my site? – Please read this article to see how to optimize your 

website: http://code.tutsplus.com/articles/10-quick-tips-optimizing-speeding-up-your-

wordpress-site 

 How to protect my site? – Please check out this website to improve security and 

understanding ways people can hack your website: http://webdesignerwall.com/general/how-

to-protect-wordpress-sites 

 How to translate or rename default theme labels?– You can use Codestyling 

localization plugin (http://wordpress.org/plugins/codestyling-localization/) to 

http://wordpress.org/download/
http://codex.wordpress.org/Installing_WordPress
http://code.tutsplus.com/articles/10-quick-tips-optimizing-speeding-up-your-wordpress-site
http://code.tutsplus.com/articles/10-quick-tips-optimizing-speeding-up-your-wordpress-site
http://webdesignerwall.com/general/how-to-protect-wordpress-sites
http://webdesignerwall.com/general/how-to-protect-wordpress-sites
http://wordpress.org/plugins/codestyling-localization/


translate/rename all theme’s labels. Other solution is to edit theme folder/languages/en_US.po 

file directly in editor and manually edit labels you want to translate. 

 

  



Installation Issues 

There might be some issues with your theme during the installation. Most of the times 

installation problems are due to limited resources, e.g. on shared hosting servers. Limited 

resources can be the PHP maximum upload/post size, the PHP maximum execution time or the 

overall memory limit. 

To solve these problems you can either allocate more resources for PHP by modifying the php.ini file 

directly. Sometimes this is not possible. In this case you can try to set these PHP settings through 

a .htaccess file on your webserver. Even though this also depends on your hosting server if it allows the 

usage of .htaccess overrides. Here’s an overview of the PHP configuration settings you should check 

and increase if needed: 

1 
2 
3 
4 

post_max_size 
upload_max_filesize 
max_execution_time 
memory_limit 

To change the PHP configuration through the php.ini file use the following syntax. 

1 
2 
3 
4 
5 

# example of recommended settings 
post_max_size = 8M 
upload_max_filesize = 8M 
max_execution_time = 60 
memory_limit = 128M 

To change the PHP configuration through a .htaccess file use the following syntax. 

1 
2 
3 
4 
5 

# example of recommended settings 
php_value post_max_size 8M 
php_value upload_max_filesize 8M 
php_value max_execution_time 60 
php_value memory_limit 128M 

As an alternative you can always use the manual installation explained in our WordPress tutorial. This 

install generally uses less resources rather than installing from a .zip file and it resolves these common 

issues: 

 PHP maximum upload/post size limits 

 Problems with PHP execution timeouts 

 Issues when unpacking the .zip file 

Additions Resources 

These are additional resources to help you find out what might be causing your WordPress installation 

to be buddy. 

 WordPress Troubleshooting 

 Common Issues 

 10 Most Common WordPress Issues 

 9 Common WordPress Problems 

 

http://www.php.net/manual/en/ini.core.php
http://php.net/manual/en/configuration.changes.php
https://premiumwd.zendesk.com/entries/23534991-Install-a-WordPress-theme
http://codex.wordpress.org/Troubleshooting
http://help.premiumwd.com/guides/getting-started/installation-issues/codex.wordpress.org/Common_WordPress_Errors
http://help.premiumwd.com/guides/getting-started/installation-issues/www.hongkiat.com/blog/common-wordpress-errors-with-solutions/
http://www.webdesignerdepot.com/2008/12/9-common-wordpress-problems-and-how-to-solve-them/


Theme Customization 

A WordPress child theme takes the functionality of another theme, named parent theme. It 

gives you the possibility to customize an existing theme. Instead of modifying the theme files 

directly, you can activate the child theme and work within it. 

All customizations are stored in the child theme and anything in the child takes priority over the 

parent. So if the same file exist in both child and parent, the file from the child will control that aspect 

of the theme. Working with child themes, your customizations are safeguarded from future upgrades 

because you only upgrade the parent theme, which you never edit, while the customizations are 

protected in your child theme which you don’t upgrade. 

Why use a Child theme? 

Safe Updates. You can easily modify your website using child themes without ever changing the 

parent theme. When a new version of the parent theme appears, you can safely update it as all your 

modifications are saved in the child theme. Easy to Extend. A child theme has a great flexibility. It 

does not require writing a lot of code. You can modify only those template files and functions that you 

need. 

 

Attention 

When you install one of our themes you must upload both parent and child theme folders to /wp-

content/themes/ but you should only enable the Child theme via Appearance > Themes. 

Modifying files from the Parent theme folder 

While you should never edit files in your Parent theme, if you really must, the safest way to do it is to 

download a copy of the file you want to modify on your computer, make the changes, and then 

upload it into your child theme folder. 

 

Information 

This way of modifying the files can be used for any files and folders from the parent theme — but you 

must re-create the same folder and filenames structure in your child theme that exist in the parent 

theme folder. 

 

  



Pages / Post Structure 

On-page optimization refers to changes you make to your website pages. There are 3 main tips 

that would greatly help you in the future when making your pages and posts. 

1. Use your keywords in the appropriate places. 

The most important places to use your keywords are your page titles, meta descriptions, and 

headings. While you do not have to fill in a meta description (search engines will use whatever text is 

relevant), it helps the search engines know what you consider important. You should also consider 

putting your keywords in bold and near the beginning of your titles, headings, and content (i.e. in the 

first sentence of the paragraph instead of the last). Use the right keywords. Don’t target general 

terms, like “Italian restaurant” or “auto repair.” Use “long-tail” keywords to improve your chances. 

Long-tail keywords are multi-word keyword phrases, typically consisting of three or more words. While 

each long-tail keyword has much lower search volume than a similar “head” keyword (i.e. “Chicago 

Italian restaurant” vs. “Italian restaurant”), your opportunity for ranking vastly improves. You simply 

cannot compete for head keywords. Consider using geographic keywords (state/province, region, city, 

neighborhood, zip code), specific names of your products/services, and proper names of people (you 

and prominent members of your staff). 

2. Write a lot of content. 

The more content you have, the more chances you have of ranking different pages on your website. 

Unless you do a lot of research, you probably won’t know what keywords will give you the most traffic 

until you accumulate enough traffic data over time. Provide valuable and informative 

content on each page and post. If your content doesn’t provide any value to your visitors, or if 

it is directly copied from another source, it will have little to no SEO value and isn’t worth 

adding. Don’t make your pages too long. Long pages won’t hurt your SEO, but if you 

separate topically relevant sections into new pages, each of those new pages has a better chance of 

ranking for different keywords. Don’t make your pages too short. There are no minimums for 

page length, but a good rule of thumb is to aim for at least 250 words. If you do not have much 

content on a page, the search engines might consider the page unimportant. 

 Alt-Attributes On Images 

 Keyword Focus 

 The title tag for your homepage 

 The heading of your site 

 As anchor text in links from other websites 

 Meta Description 

 Meta Tags 

 SEO Friendly Images 

3. Make sure your permalinks, titles, and menus are coded 

correctly. 



(The WordPress software and most WordPress themes do this automatically.) Use internal links 

with good anchor text. An internal link is a hyperlink to another page, post, or file on the same 

website. Internal links tell the search engines what content you think is relevant to the current page. 

Anchor text is the visible link text, as opposed to the URL that the link goes to. You should use your 

keywords in the anchor text wherever appropriate. Use external links in moderation. An 

external link is a hyperlink to another website. Search engines expect you to link to some other 

websites, but if you use them excessively (i.e. more than 50 on a page), you run the risk of appearing to 

the search engines as a link farm, which could lead to low rankings or de-listing. 

 Analyze and adjust. Use Google Analytics or other tracking software to find out what 

keywords are driving traffic to your website, and to which pages. You can then take steps to 

improve the keywords on those pages, making sure you do not jeopardize the traffic you are 

already getting to those pages. If you have pages that are not receiving much search traffic, 

you may want to consider rewriting those pages with different keywords. You should also 

use Google Webmaster Tools and Bing Webmaster Tools to identify potential issues with your 

website. 

 

  



Permalink Structure 

When ever we talk about SEO of any site, permalink plays major role in overall optimization. A 

permalink is Permanent link of your page and posts and it doesn’t change with time. By default 

WordPress offer permalink like this: 

http://wedding-planner.freevision.me/?p=123 Which is not search engine friendly, they miss 

out optimizing WordPress permalink for SEO. In this guide, I will be talking about which 

permalink structure is the best and will also look into other suggested WordPress permalink structure 

and why you should avoid them. 

Which Permalink Structure is recommended for SEO? 

One of the major On page SEO factor is having your Keyword in your post URL (Permalink). Default 

WordPress permalink is non SEO friendly and when you Install WordPress for the first time and start 

blogging without making any change, you are blogging with a non SEO friendly permalink 

structure. 

You can find various Permalink settings under WordPress dashboard > Settings > Permalink and few 

suggested permalink structures are: 



 Domain.com/Category/Post-name 

 Domain.com/Postname (/%postname%/) 

 Domain.com/postname/numeric-ID 

WordPress Permalink for Google News: 

If you are running a news based site for example current affairs, Bollywood news, Technology news 

kind of site, you need to have 3 digit unique ID in your permalink as mentioned in Google news 

submission requirement. 

1 /%postname%-%post_id%/ 

Some time back Matt Cutts, Google Engineer also changed his WordPress blog permalink structure to 

domain.com/post-name and here is an explanation from him: Though he didn’t mentioned any thing 

directly about SEO benefits of using simple WordPress permalink, but he did mentioned about such 

permalink helps in keeping thing simple. 

Take away and other Permalink SEO Tips: 

 Use Simple permalink (domain.com/postname) 

 Prefer dashes over underscore (Source) 

 Remove stop words from permalink like (Is, are) 

 Never change Permalink after publishing & if you do, setup a 301 redirection from old to new 

URL using .htaccess 

 Use your Keyword in Permalink 

 

  

http://support.google.com/news/publisher/bin/answer.py?hl=en&answer=40787
http://support.google.com/news/publisher/bin/answer.py?hl=en&answer=40787
http://www.youtube.com/watch?v=AQcSFsQyct8&feature=relmfu
http://www.shoutmeloud.com/how-to-edit-your-wordpress-htaccess-file.html


Titles, Tags & Meta 

One of the best way to keep getting traffic for your oldest of post is make them search engine 

friendly. 

Post Title and Meta title: 

 
 

 First thing which I want you to understand is how post title and Meta title are different. 

 Post title: That’s how your reader will see the post 

 Post Meta title: That’s what search engine will see and show in search result. 

Though it’s always a good practice to keep your target Keyword in Post title and meta title. Usually 

your Post title is H1 tag and it’s important to have your Keyword in post title. 

Tip: Keep post title less than 66 characters 

Post Meta Keywords: 



  

 

This is one of the most crucial part which we tends to ignore. Every post you write is important from 

ranking and traffic point of view. Google sees every blog post as a different webpage, so you can rank 

every post for certain keywords. Most common mistake which we make is by using the 

generic keywords in every blog post. Use Keyword research tool or tool like Traffic 

travis to see Keyword competition and searches/month. This will help you to pick the best Keyword. 

Now, use the same Keyword in your post title, post description and in Meta keywords. Though, Google 

says they don’t give any weight-age to Meta keywords, so you can ignore this. But, in such case always 

try to bold your keyword within post. Now you have keywords and post title with you, when you write a 

post, you should mention the keywords in the post. How Google is going to see this post, it will see 

the meta keywords and will try to find keywords in the post. 

Image Alt attribute: 

  

 

http://www.shoutmeloud.com/traffic-travis-review-free-seo-software.html
http://www.shoutmeloud.com/traffic-travis-review-free-seo-software.html


This is one thing which we usually ignore. We use software’s like Snag it or use sites to find the image 

for post. Though we never tend to optimize the images for keywords. Most of the time images have 

name like image001.JPG and so on. It’s always a good idea to keep the name relevant to image itself. 

For example, you take a screenshot of Adsense dashboard and now you use name as adsense. Again 

it’s not targeted. You should rather use name as Adsense-dashboard. We use a useful plugin call SEO 

friendly Image, which uses the image name as ALT attributes and thus when people search for image 

in Google Image search, will land on your blog post. If not, you can always manually add Alternate text 

while you upload an image. I have seen positive effect of using Keyword in image anchor text, so 

atleast use your Keyword in one of the image alt text. 

Interlink and Anchor text: 

When we write a new post, it’s always a good idea to link back to old post. So that readers will find the 

old posts and also search engine will re-crawl the old blog post. Now when you interlink, you should 

use the anchor text technique to interlink. In simple words, when you link to a blog post, you see an 

option to add Link and title. Make sure you fill out the post title or main keywords for the post you are 

linking to. 

 

  

Permalink and remove stop words: 

  

 

When we write a post, we usually use post title with lots of stop words. You can find a comprehensive 

list of Stop Words here and here. So for example, when we write a post with title: 3 ways to make a 

blog business plan. Your post permalink by default would be: domain.com/3-ways-to-make-a-blog-

business-plan.html Now there are many stop words in this: For example: to, a. You can click on edit 

permalink and change the permalink to Blog-business-plan. 

http://www.agent-seo.com/seo/seo-stop-words/
http://www.link-assistant.com/seo-stop-words.html


H1, H2, H3 Headings: 

  

 

By default in any SEO optimized theme, post title is H1 tags. So for next sub heading you can use H2 

heading, and H3 heading and so on. Specially when you writing a long post, it’s always a good idea to 

use proper heading tags for effective SEO. You can refer to following posts for better understanding of 

how to use headings within blog posts.< Link1>  <Link 2> According to SEO community, it’s a good 

idea to use your Keyword in H1, H2, H3 Tags. Quick Checklist: 

 Post title for readers & search engine (Keyword in H1, H2, H3 and Post title) 

 Post Permalink (Stop words free and Keywords in Permalink) 

 Interlinking within post with Anchor text 

 Image Alt text (Keyword) 

 Post meta description (Optimize it for better CTR and use your target keyword once) 

 Post Meta keywords (Could be ignored) 

 Link to on external high MOZrank source. 

 

  

http://www.mediacollege.com/internet/html/heading.html


Get Instagram Client Id 

 Instagram is an online photo, video sharing and social networking service that enables its users to 

take pictures and videos, and share them on a variety of social networking platforms, such as 

Facebook, Twitter, Tumblr and Flickr. 

 

 What is Instagram Client Id? Instagram  Client Id is an encrypted key which is generated form 

instagram developer center using instagram account. Client id usages by application software which is 

installed on your website or mobile devices.  

 

Why we need Instagram Client Id? Client Id usages via different apps, plugins, software 

extensions to authenticate application request on Instagram server. These application usages your 

client id to fetch your instagram account details like photos, video, account information. When a 

application request to instagram server than server validate the client id and send all the requested 

information to application which is installed on your site. Next we are explaining to generate your own 

Client Id form using own instagram account.  

 

Just simply follow the step by step tutorial to get your own Instagram client id 

Step 1 

First go to Instagram developer center. Click-Here to open URL.     

Step 2 

http://instagram.com/developer
http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/instagram.jpg


After URL opened into new tab you will see same screen as below screenshot. Click on Login menu 

which is highlighted in screenshot.

 

Step 3 

After click on login link in menu you will be redirected on login page. Fill your account credentials and 

click on Log in button. 

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/1-click-on-login-link.jpg


  

Step 4 

After successful login you will see Instagram developer client dashboard. Now, click on Register 

Your Application button which is highlighted in below screenshot. 

 

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/2-login-form.jpg


 

Step 5 

Now you will be redirected to Mange Clients page. Here you will find a green color 

button Register a New Client. So, click on it same as screenshot. 

 

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/3-register-your-application.jpg


 

Step 6 

A Register a New Client Id form page will open on same screen. Fill the form details according 

to your application needs. In this tutorial we are filling the details according to Instagram 

Shortcode & Widget WordPress plugin. And the sample details as below:  

 

1) Application Name – WordPress Plugin (you can define your app name here, but don’t use 

instagram keyword into this field)  

 

2) Description – Instagram WordPress plugin to display your instagram photos on WordPress blog 

site. (define your app basic working details here)  

 

3) Company Name – Type a company name  

 

4) Website URL – you can provide your site domain URL in this field where you using this app  

 

5) Valid Redirect URI(s) – http://freevision.me/instagram/callback  

 

6) Privacy Policy URL – you can provide your site domain URL in this field where you using this 

app  

 

7) Email – Provide your email address in this field  

 

8) ReCaptcha – enter the captcha code value in this field for secure registration procedure by 

Instagram.  

 

http://freevision.me/instagram/callback
http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/4-click-on-register-a-new-client.png


9) Register – Finally after filling all valid details in form click on register button to complete 

register.  

Note : Do not pass the uncheck Disable implicit OAuth on Security tab. 



 

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/new_client.jpg


 

Step 7 

After successful registration completion you will find your client id as marked in bellow 

screenshot. 

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/new_client_security.jpg


 Now you can copy and use Client ID in any application. Thanks for reading this article & your 

feedback and suggestions are appreciated to improve this article. 

 

  

http://doc.freevision.me/wedding-planner/wp-content/uploads/sites/13/2016/06/manage_clients.jpg


Hosting 
Our themes require that you have WordPress installed and running on a web hosting account. We 

recommend you use a host trusted by WordPress that has quality products and service. Many users 

ask us who we recommend and we have two companies to share with you. 

MediaTemple    BlueHost 

 

  

https://mediatemple.net/webhosting/wordpress/
https://www.bluehost.com/wordpress


 

10 WordPress Security Tips 

In line with our serious approach to security, our products are carefully optimized to be as secure as 

possible. There are, however, still a handful of potential security risks, when running a website, that we 

have no control over. You, the website owner, need to pay attention to these potential security risks, in 

order to keep your website safe. 

With that in mind, here are 10 things you can do to improve your WordPress security. 

1. Change the Database Prefix 

A lot of the basic setup stuff for WordPress is the same across lots of sites… especially if you use a 

one-step install wizard through your webhost. This is super convenient, but lots of common setup 

values like, your database prefix(es), are known to hackers as a result. If you don’t change the database 

prefix, the table names of your site’s database are easily known to the person who trying to hack your 

site. 

 

  

2. Protect Your wp-config.php / .htaccess File 

As mentioned earlier, the wp-config.php file contains all the confidential details of your site. So it’s 

pretty important that you protect it at all costs. An easy way to protect this file is to simply place the 

following code in your .htaccess file on your server. 

1 
2 

order allow,deny 
deny from all 

We can protect our wp-config.php file as mentioned above, but what about protecting the .htaccess 

file itself? Don’t worry, we can use the same .htaccess file to protect itself from being preyed upon. You 

just need to place below code in your .htaccess file. 

1 
2 

order allow,deny 
deny from all 

3. Strengthen up those passwords 

According to this infographic, around 8% of hacked WordPress websites are down to weak passwords. 

If your WordPress administrator password is anything like ‘letmein’, ‘abc123’, or ‘password’ (all way 

more common than you might think!), you need to change it to something secure as soon as possible. 

For a password that’s easy to remember but very hard to crack, I recommend coming up with a 

good password recipe. If you’re feeling lazy, you can also use a password manager like LastPass to 

remember all your passwords for you. If you use this method, make sure your master password is nice 

and strong. 

http://www.wptemplate.com/features/safety-and-security-of-wordpress-blog-infographic.html
http://luigimontanez.com/2010/password-recipes/
http://lastpass.com/


4. Never use “admin” as your username 

Earlier this year, there was a spate of brute-force attacks launched at WordPress websites across the 

web, consisting of repeated login attempts using the username ‘admin’, combined with a bunch of 

common passwords. If you use “admin” as your username, and your password isn’t strong enough (see 

#3), then your site is very vulnerable to a malicious attack. It’s strongly recommended that you change 

your username to something less obvious. Until version 3.0, installing WordPress automatically created 

a user with “admin” as the username. This was updated in version 3.0 so you can now choose your own 

username. Many people still use “admin” as it’s become the standard, and it’s easy to remember. Some 

web hosts also use auto-install scripts that still set up an ‘admin’ username by default. Fixing this is 

simply a case of creating a new administrator account for yourself using a different username, logging 

in as that new user and deleting the original “admin” account. If you have posts published by the 

“admin” account, when you delete it, you can assign all the existing posts to your new user account. 

5. Hide your username from the author archive URL 

Another way an attacker can potentially gain access to your username is via the author archive pages 

on your site. By default WordPress displays your username in the URL of your author archive page. e.g. 

if your username is joebloggs, your author archive page would be something 

like http://yoursite.com/author/joebloggs This is less than ideal, for the same reasons explained 

above for the “admin” username, so it’s a good idea to hide this by changing the user_nicename entry 

in your database, as described here. 

6. Limit Login Attempts 

In the case of a hacker or a bot attempting a brute-force attack to crack your password, it can be 

useful to limit the number of failed login attempts from a single IP address. Limit Login Attempts does 

just that, allowing you to specify how many retries will be allowed, and how long an IP will be locked 

out for after too many failed login attempts. There are ways around this, as some attackers will use a 

large number of different IP addresses, but it’s still worth doing as an additional precaution. 

7. Hide Your WordPress Version 

Another good idea is to remove the generator meta for the WordPress. This meta shows the version of 

your WordPress site. If you have enabled the WordPress version, then hackers will know the security 

lacking of your website. If you absolutely can not update your WordPress version (tip #1), this is a 

good failsafe to at least hide the fact that you’re not on the most current version. To do this you need 

to place below code in function.php of your active theme. 

1 remove_action('wp_head', 'wp_generator'); 

You can go one step further and additionally remove it from RSS feeds using this: 

1 
2 
3 
4 

function wpt_remove_version() { 
return ''; 
} 
add_filter('the_generator', 'wpt_remove_version'); 

The trouble is, if a hacker managed to gain access to your admin panel, they could also edit your files 

that way, and execute whatever code they wanted to. So it’s a good idea to disable this method of file 

editing, by adding the following to your wp-config.php file: 

1 define( ‘DISALLOW_FILE_EDIT’, true ); 

8. Try to avoid free themes 

http://techcrunch.com/2013/04/12/hackers-point-large-botnet-at-wordpress-sites-to-steal-admin-passwords-and-gain-server-access/
http://ma.tt/2013/04/passwords-and-brute-force/
http://www.websitedefender.com/faq/change-default-wordpress-admin-username/
http://itpixie.com/2012/10/hide-your-wordpress-login-from-author-archive/
http://wordpress.org/plugins/limit-login-attempts/


We’re confident in the quality and security of our free themes. As a general rule though, it’s better to 

avoid using free themes, if possible, especially if they aren’t built by a reputable developer. The main 

reason for this is that free themes can often contain things like base64 encoding, which may be used 

to sneakily insert spam links into your site, or other malicious code that can cause all sorts of problems, 

as shown in this experiment, where 8 out of 10 sites reviewed offered free themes containing base64 

code. If you really need to use a free theme, you should only use those developed by trusted theme 

companies, or those available on the official WordPress.org theme repository. Note: The same logic 

applies to plugins. Only use plugins that are listed on WordPress.org, or built by a well-established 

developer. 

9. Keep a backup 

I can’t overemphasize the importance of making regular backups of your website. This is something 

that many people put off until it’s too late. Even with the best security measures at your disposal, you 

never know when something unexpected could happen that might leave your site open to an attack. If 

that happens you want to make sure all of your content is safely backed up, so that you can easily 

restore your site to its former glory. The WordPress Codex tells you exactly how to backup your site, 

and if that seems like too much hard work, you can use a plugin such as WordPress Backup to 

Dropbox to schedule regular automatic backups. 

10. Create Custom Secret Keys for Your wp-config.php File 

All of the confidential details for your WordPress site are stored in the in your WordPress root 

directory. Secret keys are one of the bits of information stored in that file… so make sure you 

change the default secret keys to something else. 

 
If you are not sure for what to place in the default values, go to this link, and it will generate the 

random keys for you. 

Further Resources 

http://en.wikipedia.org/wiki/Base64
http://wpmu.org/why-you-should-never-search-for-free-wordpress-themes-in-google-or-anywhere-else/
http://codex.wordpress.org/WordPress_Backups
http://wordpress.org/plugins/wordpress-backup-to-dropbox/
http://wordpress.org/plugins/wordpress-backup-to-dropbox/
https://api.wordpress.org/secret-key/1.1/salt/


To learn more about hardening your website’s security, please check out these two 

resources: http://codex.wordpress.org/Hardening_WordPress http://wp.tutsplus.com/tutorials/11-

quick-tips-securing-your-wordpress-site We also recommend Sucuri.net if you are unsure about this 

topic. Sucuri can help monitor your site, alert you of suspicious activity and even help clean up your 

site in the case of a malware attack. 

 

  

http://codex.wordpress.org/Hardening_WordPress
http://wp.tutsplus.com/tutorials/11-quick-tips-securing-your-wordpress-site
http://wp.tutsplus.com/tutorials/11-quick-tips-securing-your-wordpress-site
http://sucuri.net/


 

License FAQ 

Our themes are released under the MIT license and is copyright 2016 FreeVision. 

It requires you to: 

 Include the license and copyright notice in your works 

It permits you to: 

 Freely download and use our themes and or our framework, in whole or in part, for personal, 

private, company internal, or commercial purposes 

 Modify the source code 

It forbids you to: 

 Grant a sublicense to modify and distribute our themes and or our framework to third parties 

not included in the license 

 Use our themes and or our framework in packages or distributions that you create 

 Hold the authors and license owners liable for damages as of our themes and or our 

framework is provided without warranty 

 Hold the creators or copyright holders of FreeVision liable 

 Redistribute any piece of our themes and or our framework without proper attribution 

 Use any marks owned by FreeVision in any way that might state or imply that FreeVision 

endorses your distribution 

 Use any marks owned by FreeVision in any way that might state or imply that you created the 

FreeVision software in question 

It does not require you to: 

 Include the source of our themes and or our framework itself, or of any modifications you may 

have made to it, in any redistribution you may assemble that includes it 

 Submit changes that you make to FreeVision (though such feedback is encouraged) 

 

  



 

Licensing 
When purchasing Wedding Planner from ThemeForest, you have two licensing options. The Regular 

License, and the Extended License. The billing, licensing terms and process is purely handled 

by Envato (the company who owns ThemeForest), and we have no control over these aspects. To learn 

more about what each License is for and which one to purchase, continue reading below. 
Click Here To View License Information        Buy Another Wedding Planner license! 

Common Questions 

1. If I need to use Wedding Planner on a second site, do I 

need a second license? 

Yes. One purchase of Wedding Planner allows you to use the theme on one finished site. If you need 

to use it on a second site, it requires you to make a second license purchase. 

2. Can I use Wedding Planner on a test site, then move it to a 

live site when finished? 

Yes, you can. You can keep the theme on a test site to build it, then move it to the live site once you’re 

finished. 

3. Can I keep a test site and a live site with one Regular 

License purchase? 

According to the licensing rules set by Envato, this is not allowed. If it is installed in two places 

permanently, then it requires two licenses. 

 

  

http://www.envato.com/
http://themeforest.net/licenses/standard?license=regular
http://themeforest.net/licenses/standard?license=regular


 


